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Why SmartCtrl?  Top Next

SmartCtrl is the control designing tool for power electronics. It provides an easy to use interface for
designing the control loop of almost any plant.
It includes the predefined transfer functions of some of the most commonly used power electronics
plants, such as different DC/DC topologies, AC/DC converters, Inverters and motor drives.

However, it also allows the users to import their own plant transfer function by means of a text file.
Therefore, this feature provides flexibility to design an optimized control loop for almost any system.

In order to make easier the first attempt when designing a control loop, an estimation of the stable
solutions space is given by the program under the name of "solutions map". Based on the selected
plant, sensor and type of regulator, the solutions map provides a map of the different combinations of
fc and phase margin that lead to stable systems.

Thus, the designer is able to select one of the points of the stable solutions space and to change the
regulator parameters dynamically in order to adjust the system response to the user requirements in
terms of stability, transient response, ... Since the program provides, at a glance, the frequency
response of the system as well as the transient response and the regulator component values for the
open loop given features. All of them are real time updated when any parameter of the system is varied
by the designer.

Key Features

·               Pre-defined transfer functions of commonly used power electronics plants and
sensors.

·               Possibility of importing any transfer function by means of a .txt file

·               Estimation of the stable solutions space ("Solutions Map")

·               Dynamic variation of the system parameters.

·               Real time updated results of both the frequency response (bode plots) and the system
transient response.

  

1



Program Layout  Top  Next

When SmartCtrl is started, all the available options are shown, and the user can select which of them is
going to use. The aforementioned window is shown below. It is divided into two sections:

1.    Design a new converter control loop
Within this section the available options are the following:
                Single loop DC/DC converter
                Single loop converter using an imported transfer function
                Double loop DC/DC converter
                PFC converter

2.    Import a ...
                        Recently saved file
                        Previously saved file
                        Predefined converter

Regardless of the selected option, once the converter is completely defined, the main window of the
program is displayed. Different areas are considered within the main window and all of them are briefly
described below:

1.    There are six drop-down menus , this is:
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File It includes all the functions needed in order to manage files, import and export
files,  establish the printer setup and the print options

Data SmartCtrl libraries and parametric sweep

View Allows the user to select which elements are displayed and which are not

WindowFunctions to create, arrange and split windows

Help SmartCtrl Help

2     The Main Toolbar provides quick access to the most commonly used program functions through
left click on the respective icon.

3     The View Toolbar icons allows the user a quick selection of the elements displayed.

4     The Status Bar summarizes the most important parameters of the open loop control design
(cross frequency, phase margin and attenuation at the switching frequency)

5     The regulator Design Method Box includes the three calculation methods of the regulator as
well as the Solution Map .

6      Graphic and text panels includes the most relevant information of the system: frequency
response, polar plot, transient response, input data and the designed regulator components. To
access the help topic regarding each panel just right click on that panel.
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File Menu
New Create a new project (Ctrl+N)

New and initial dialog Create a new project and displays the initial dialog box

Open Open an existing project (Ctrl+O)

Open sample designs Open a sample design from the examples folder

Close Close the current project window

Save Save the current project (Ctrl+S)

Save as... Save the current project to a different file

Open txt files Open any .txt file in Notepad

Import (Merge) Merge data of another file with the data of the existing file for
display. The curves of these two files will be combined. (Ctrl+M)

Export The program provide  different  exporting  options.  It allows
exporting the following:

Export transfer functions

Export regulator components to either a txt file, a PSIM
parameter file or a PSIM schematic file

Export transient responses to a file. The available
transient responses are: voltage reference step, output
current step and input voltage step

Generate report Generates a report  to either  a .txt  file  or notepad.  It contains
information regarding  both the input data (steady-state  dc
operating point, plant input data, ...) and output data (regulator
components, cross frequency, phase margin, ...)

Print preview Preview the printout  of any of the graphic  and text  panels  (
Transfer function  modules  (dB), Transfer  function  phase (º),
Nyquist diagram, Transients, Data input, Results)

Print Print any of the panels of the main window (bode plots, Nyquist
diagram, transient, input data or results)

Printer setup Setup the printer

Exit Exit SmartCtrl program
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Design Menu
The SmartCtrl Design Menu contains the elements that can be used in the SmartCtrl schematic.
The library is divided into the following sections:

Predefined Topologies Contains the most commonly used DC/DC plants both in
single and double loop configurations, as well as AC/DC
plants.

Imported transfer function Allows the use of a generic transfer function by means
of the import of a .dat, .txt, or .fra file

Modify Open the schematic window of the current project to
modify the parameters

Parametric Sweeps Allows to perform the sensibility analysis of the system
parameters. It is divided into two different parametric
sweeps: Input Parameters and Regulator Components

Reset all Clears the active window

5
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View Menu
Comments Opens the comments window. It allows the user to add comments to the

design. These comments will be saved together with the designed
converter.

Loop Select the loop to be displayed in the active window (inner or outer loop)

Transfer Functions Select the transfer function to be displayed

Plant transfer function, G(s)

Sensor transfer function, K(s)

Regulator transfer function, R(s)

Sensor-Regulator transfer function, K(s)*R(s)

Open loop without regulator transfer function, A(s)

Open loop with regulator transfer function, T(s)

Closed loop transfer function, CL(s)

Transients Select the transient response to be displayed. The available transient
responses are:

Input voltage step transient

Output current step transient

Reference step transient

Organize panels Resize all panels and restore the default appearance of the graphic and
results panels window.

Enhance Select the panel to be displayed in full screen size

Bode (modulus) panel (Ctrl+Shift+U)

Bode (phase) panel (Ctrl+Shift+J)

Nyquist diagram panel (Ctrl+Shift+I)

Transient responses panel (Ctrl+Shift+K)

Input data panel (Ctrl+Shift+O)

Output (results) panel (Ctrl+Shift+L)
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Window Menu
New Window Create a new window

Maximize active window Maximize the current window

Cascade Arrange the windows in cascade form

Tile horizontal Tile the currently open windows horizontally

Tile vertical Tile the currently open windows vertically

Split Click on the intersection of the lines that delimit the
different window panels and drag. This will change the size
of the panels

Organize all It restores the default size of the graphic and text panels.
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Main toolbar Previous Top Next

        Create a new project

        Create a new project and open initial dialogue box

        Open an existing project

        Open sample design

        Close the current project window

        Generate report

        View document comments

        Open the single loop DC/DC data input dialogue box

       Import plant transfer function, voltage mode controlled

        Import plant transfer function, current mode controlled

        Open the double loop DC/DC data input dialogue box

        Open the Boost PFC converter data input dialogue box

        Save the current project

        Export transfer function to a file

      Import transfer function from a file to be merged with the current project

       Export regulator to PSIM (schematic)

        Export regulator to PSIM (parameters file)

        Update parameters file of the previously exported regulator

        Maximize active window

         Tile windows

         See all panels

       Organize all panels
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View toolbar Previous Top Next

      Display the frequency response (Bode plot) of the plant transfer function

      Display the frequency response (Bode plot) of the sensor transfer function

      Display the frequency response (Bode plot) of the open loop without regulator transfer function

      Display the frequency response (Bode plot) of the sensor regulator transfer function

      Display the frequency response (Bode plot) of the regulator transfer function

      Display the frequency response (Bode plot) of the open loop transfer function

      Display the frequency response (Bode plot) of the closed loop transfer function

       Display transient response due to a reference voltage step

      Display the transient response due to an output current step

      Display the transient response due to an input voltage step

      Display inner loop results

      Display outer loop results

      Enables or disables the display of the regulator calculation method toolbox

      Input Parameters Parametric sweep

      Input Parameters Parametric sweep
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Import your own Transfer Functions Previous Top Next

One of the Key Features of SmartCtrl is the possibility of using a generic plant transfer function
imported from a .txt file.

Thanks to this feature, the designer is able to carry out the regulator design and optimization when a
generic plant is used. The system average model is not needed, but the plant transfer function, which
can be obtained by means of experimental measurements or AC simulation .

To perform the single loop design from an imported plant transfer function just enter the data menu
and select imported transfer function. Within this option two options are available:

                Current mode controlled

                Voltage mode controlled

Other available path to access this option are the icons placed within the main toolbar.

                        Import plant transfer function, voltage mode controlled

                         Import plant transfer function, current mode controlled 

To load the plant from a file follow the instructions below. SmarCtrl is able to load the following file
formats: *.dat, *.txt, *.fra
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Once the file has been selected, the transfer function is displayed in module and phase.

Some additional data must be specified:
The switching frequency (Fsw) in Hertz.
The desired output voltage (Vo) in Volts. (Only if the plant is voltage mode controlled).

To continue with the single loop design just click OK.
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Imported plant single loop design Previous Top Next

The single loop is formed by three different transfer functions: plant, sensor and regulator, that must be
selected sequentially.Whether the imported plant is voltage mode controlled or current mode
controlled, the single loop design process is the same in any case. The only difference are the sensors
available in each case.

The imported transfer function has been already loaded. Whether it is a current mode controlled or
voltage mode controlled, the available sensors are the following:
  

Voltage mode controlled
Voltage divider
Reg. Embedded Voltage Divider

Current mode controlled
Current sensor
Hall effect sensor

Finally, the regulator is selected.
  

Regulator types:
•    Type 3
•    Type 3 Unattenuated
•    Type 2
•    Type 2 unattenuated
•    PI
•    PI unattenuated
•    Single Pole
    Single Pole unattenuated

Once the system has been defined, SmartCtrl calculates the stable solution space in which all the
possible combinations of crossover frequency and phase margin that lead to stable solutions are shown
graphically. It is called Solutions Map.

The designer is asked to select a point within the solution space to continue. To do that, just click on Set
and select a point within the white zone.
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Now accept the selected point and confirm the design, the program will automatically show the
performance of the system in terms of frequency response, transient response... (See Graphic and text
panels window for detailed information)
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Export transfer functions Previous Top Next

SmartCtrl provide three different exporting options which are available under the export item of the File
Menu. The first of the exporting options is export transfer functions which is also available  through left
click on the icon  placed in the main toolbar.

Any of the transfer functions available can be exported to a .txt file. To do that, the designer must select
the function to export within the available list and set the options of the file in the corresponding
dialogue box.

The addressed file is formed by three columns containing the frequency vector, the module in dB and
the phase in degrees respectively.

The file options and characteristics are contained in the "Exporting transfer function dialogue box" and
they are described below:
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File Header It contains the name of the three columns of the file.

 
Export function
between

The designer is able to set the frequency range of the exported
transfer function

 
Number of points Number of points to be saved in the file
                                
Points will be equi-spaced along a:
                Logarithmic scale in the frequency axis
                Decimal scale in the frequency axis

Data separated by:
                tabs
                spaces
                commas
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Export regulator to PSIM Previous Top Next

Another of the exporting options provided by SmartCtrl allows to communicate the program itself with 
PSIM software.

Once the regulator has been designed, it can be exported easily to PSIM in order to carry out a
simulation.

There are three different options for exporting the regulator which are briefly described below:
     Export regulator to PSIM (schematic) 

The designer is able to export the designed regulator to PSIM in an schematic form. This
is, the user will be asked to select the PSIM file in which the regulator schematic will be
inserted.

Two different schematics are available:

ü  Components (R1, C1, ...)
ü  s domain coefficients

The user will be asked to select one of them:
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Finally, the regulator is inserted in the selected Psim schematic file:

Components (R1, C1, ...)ü

s domain coefficientsü
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Export regulator to PSIM (parameters file)

In this  case,  only the parameters file will  be exported to PSIM. Similarly to the
previous option, SmartCtrl will ask the designer to select the PSIM schematic to
which the parameters file must be exported.

Two different schematics are also available:

Components (R1, C1, ...)ü
s domain coefficientsü

Update parameters file

Once one of the  previously  described  options  have  been  performed,  only  the
updating of the existing parameter file is needed.
When the  designer  click on this  option,  the  previously  inserted  parameter  file
will be updated automatically.
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Export transient responses Previous Top Next

SmartCtrl provides three different exporting options which are available under the export item of the
File Menu. The third of the exporting options is "export transient functions" which export any of the
available transient responses to a file.

This option is also available through right click on the transient response graphic panel. The
corresponding dialogue box is displayed below. It shows the transient response to be exported as well
as the following parameters:

Time shift                                                        The user is able to set a customized time shift (in
seconds) if necessary, and the transient response will be
translated accordingly along the time axis.

N. of points to be exported                     SmartCtrl shows the total number of points of the graph.

Print step                                                        Its default value is 1 and it means that every data point
will be exported to the file. If it is 4, only one out of 4
points will be saved. This helps to reduce the size of the
resultant file. The two buttons placed at both sides of the
pint step box allow to increase (x2) or decrease (/2)  the
print step easily.
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Click Apply to update the parameters and OK to continue. At this point, the program will ask you
the name and location of the file.
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Import (Merge) Previous Top Next

Import (Merge) data of another file with the data of the existing file for display. The curves of these
two files will be combined. The Merge function is available within the File Menu and through click on

. It is oriented to the comparison of frequency response curves (Bode plots).

The file to be merged with the current one can be either a .tro file, a .txt file or a .fra. This is, the
comparison of the current file results can be compared with the results previously saved by the
SmartCtrl Program, with any transfer function saved in a .txt format or with a PSIM frequency AC
analysis, respectively.

Neither the .tro file or the .fra file need to be formatted in order to be used by the merge function.
However, if a .txt file is going to be used the following considerations must be taken into account:

                The file must be organized in three columns (from left to right)

                                First column corresponds to the frequency values

                                Second column correspond to the module in dB

                                Third column correspond to the phase in degrees

                The first line of the file corresponds to the columns headings

The next steps will guide you to add, modify or delete transfer functions to/from the comparison, either
from a .tro file or a .txt file.

1. Merge

You can select the Merge function both from the File Menu or through left click on   from the main

toolbar.

2. Available actions

You can choose among the following available actions:
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2. Available actions

You can choose among the following available actions:

Add Adds a new transfer function to the comparison

Modify Modify the settings of a previously added transfer function (change color, file of
origin...)

Delete Deletes the selected function

Delete all Delete all the functions

Apply Apply the current settings

OK Apply the current settings and close the merge window

Cancel Close the Merge window but don't apply any change

Help Display the help window
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Add Function Previous Top Next

The Add function to merge allows the user to add a new transfer function to the comparison

1. Select the Function Type

Where:

G(s)Plant Transfer Function

K(s) Sensor Transfer Fucntion

A(s)=G(s)*K(s)

R(s) Regulator Transfer Function

K(s)*R(s)

T(s)=A(s)*R(s) Open loop transfer function

CL(s) Closed loop transfer function

2. Select the color

3. Load function from .tro or .txt file

Load function from either a .tro file or a text file (.txt)
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4. OK

And the transfer function will be added to the module and phase panels of the Bode Plots
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Modify Function Previous Top Next

The Modify function allows the user to Modify the settings of a previously merged transfer function
(change color, file of origin...)

1. Select the Function to be modified

2. Click on the Modify button

3. Modify settings

The user is able to modify the following parameters:

                Load a new file

                Change the trace color

However, if the user modifies the function type, a
new file must be loaded
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Single loop Previous Top Next

The single loop is formed by three different transfer functions: plant, sensor and regulator, that must be
selected sequentially.

The first step to define the system is the selection of the plant.The plant can be either a pre-defined one
or a user own one. This is, the user can import a generic transfer function by means of a .txt file or
select one of the pre-defined topologies.

  

The predefined DC/DC plants are the
following:

·    Buck

·    Buck-Boost

·    Boost

·    Flyback

·    Forward

Once the plant has been selected, regardless the magnitude to be controlled is voltage or current, the
program will display the appropriate type of sensor.

  

The different sensors available are the
following:

·    Voltage Divider

·    Regulator Embedded Voltage
Divider

·    Isolated Voltage Sensor

·    Current Sensor

·    Hall Effect Sensor

Finally, the regulator is selected. SmartCtrl provides different regulators as well as the possibility of
importing the transfer function of a new one through a text file.

  
Regulator types:

·    Type 3

·    Type 3 Unattenuated

·    Type 2

·    Type 2 unattenuated

·    PI

·    PI unattenuated

·    Single Pole

·    Single Pole unattenuated

Once the system has been defined, SmartCtrl calculates the stable solution space in which all the
possible combinations of crossover frequency and phase margin that lead to stable solutions are shown
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are shown graphically. It is called Solutions Map.

The designer is asked to select a point within the solution space to continue. To do that, just
click on Set and select a point within the white zone.

Now accept the selected point and confirm the design, the program will automatically show the
performance of  the system in terms of  frequency response,  transient  response...  (See Graphic
and text panels window for detailed information)
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Double loop Previous Top Next

The double loop option is formed by an inner current loop and an outer voltage mode loop. As well as
the single loop, the double loop setup must be built sequentially. The program will guide you to built it,
enabling the following step and keeping everything else disabled.

In all the available plants, the outer loop is a voltage mode control (VMC), while the inner loop is a
current controlled one. Depending on the selected plant, the current is sensed either on the inductance
(LCS) or on the diode (DCS). The DC/DC plant must be selected among the following list.

  

The predefined DC/DC plants are the
following:

·    Buck (LCD-VMC)

·    Buck-Boost (LCS-VMC)

·    Boost (LCS-VMC)

·    Boost (DCS-VMC)

·    Flyback (DCS-VMC)

·    Forward (LCS-VMC)

Next, the inner control loop will be configured. This is, the current sensor and the regulator type must
be selected.

  

The available current sensors are the
following:

·    Current Sensor

·    Hall Effect Sensor

Finally, the inner loop regulator is selected.
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Regulator types:
Type 3
Type 2
PI
Single Pole

Once all the  inner  loop  transfer  functions  have  been  defined, The cut off  frequency and the
phase margin must be selected.  Under the name of Solution Map, SmartCtrl provides the stable
solution space in which all the possible combinations of cut off frequency and phase margin that
lead to stable solutions are shown graphically. Just clicking on the "Solutions map (inner loop)"
button the solution map corresponding to the inner  loop is displayed.
The designer is  asked to select the crossover frequency and the phase margin  just  by clicking
within the white zone to continue.

Once the cut off frequency and the phase margin have been selected, the solution map will be
shown on the right of the side of the DC/DC double loop input data window. If, at any time, the
two aforementioned parameters need to be changed, just click on the shown solution map. (See
next figure)
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Now, the outer loop can be defined. First, the voltage sensor must be selected.

  

The different sensors available are the
following:

·    Voltage Divider

·    Regulator Embedded Voltage
Divider

Next, the outer loop regulator must be selected.

  
Regulator types:

·    Type 3

·    Type 3 Unattenuated

·    Type 2

·    Type 2 unattenuated

·    PI

·    PI unattenuated

·    Single Pole

·    Single Pole unattenuated

As well as in the case of the inner loop, the cut off frequency and the phase margin must be selected.
Also in this case, the solution map is available to help the selection of an stable solution.
Press the "Solution map (outer loop)" button and the solution map will be displayed. Then select a point
just by clicking within the white area.

It should be remarked that, due to stability constraints, the crossover frequency of the outer loop
cannot be greater than the crossover frequency of the inner loop. In order to prevent the selection of an
outer loop fc greater than the inner loop one, a pink shadowed area has been included in the solutions
map of the outer loop.
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It should  be  remarked  that,  due to stability  constraints,  the  crossover  frequency of the  outer
loop cannot be greater than the crossover frequency of the inner loop. In order to prevent the
selection of an outer  loop fc greater than the inner loop one, a pink shadowed area has been
included in the solutions map of the outer loop.

Once the crossover  frequency and the phase margin have been selected, the solution map will
be shown on the right of the side of the DC/DC double loop input data window. If, at any time,
the two aforementioned parameters need to be changed, just click on the shown solution map.
(See next figure)

Now accept the selected configuration and confirm the design,  the program will  automatically
show the performance of the system in terms of frequency response, transient response... (See
Graphic and text panels window for detailed information)
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DC/DC Plants Previous Top Next

For every DC/DC converter, the input data window allows the user to select the desired input
parameters and also provides useful information such as the steady state dc operating point. For any of
the considered DC/DC topologies, the input data correspond to the white shadowed boxes, and the
additional information provided by the program will be shown in the grey shadowed boxes.

Lets consider any of the available converters.  In the following picture it can be seen that the parameters
which define the steady-state dc operating point are placed right below the converter image. Depending
on the topology considered in each case, some of them will be input data and some others will be
output data.

The DC/DC available plants are the following:

Buck

Boost

Buck-Boost

Flyback

Forward

Text File
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Buck Previous Top Next

When a single loop control scheme is used, the magnitude to be controlled in a buck converter can be
either the output voltage or the inductance current. Both possibilities have been included in SmartCrl.
The schematics are shown below:
  

Voltage Mode Controlled Buck L-Current Sensed Buck

In the case of a double loop control scheme, two magnitudes must be sensed simultaneously, a current
and the output voltage. The resultant buck scheme is the following:

Buck (LCS-VMC)

The input data window allows the user to select the desired input parameters and provides useful
information such as the steady state dc operating point. This information is placed right below the
converter image.
Two examples of the input data window are shown below, in each of them, the white shadowed boxes
correspond to the input data boxes while the grey shadowed ones correspond to the additional
information provided by the program.
Please, note that the input data is different in case of a voltage controlled plant (output voltage is an
input) or a current controlled plant (in this case the current to be controlled is the input data). An
example of the input data windows is provided below:

Input Data Window of a Voltage Mode Controlled Buck
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Input Data Window of a Current Mode Controlled Buck

The parameters shown in the input data windows are defined below:

Steady-state dc operating point

Conduction Mode           It can be Continuous or Discontinuous
Duty Cycle                          ton/T of the active switch
IL avg                                    Inductance average current (A)
IL max                                   Maximum value of the inductance switching ripple (A)
IL min                                    Minimum value of the inductance switching ripple (A)
Io avg                                    Output average current (A)
Vo                                          Output voltage (V)

Other parameters of the converter

                Vin           Input Voltage (V)
                RL            Equivalent Series Resistor of the Inductance (Ohms)
                L              Inductance (H)
                Rc           Equivalent Series Resistor of the output capacitor (Ohms)
                C             Output Capacitor (F)
                R             Load Resistor (Ohms)
                Po            Output Power (W)
                FSW         Switching frequency (Hz)
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Boost Previous Top Next

There are three possible magnitudes to be controlled in the boost converter when a single loop control
scheme is selected, this is the output voltage, the inductor current and the diode current. The
respective schematics are the following:
  

Voltage Mode Controlled Boost Converter

L-current sensed Boost Converter

Diode Current Sensed Boost Converter

In the case of a double loop control scheme, the output voltage and a current must be sensed
simultaneously. The available plants for double loop designs are included below:

Boost (LCS-VMC)

Boost (DCS-VMC)

The input data window allows the user to select the desired input parameters and provides useful
information such as the steady state dc operating point. This information is placed right below the
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converter image.
Two examples of the input data window are shown below, in each of them, the white shadowed boxes
correspond to the input data boxes while the grey shadowed ones correspond to the additional
information provided by the program.
Please, note that the input data is different in case of a voltage controlled plant (output voltage is an
input) or a current controlled plant (in this case the current to be controlled is the input data). An
example of the input data windows is provided below:

Input Data Window of a Voltage Mode Controlled Boost

Input Data Window of a Current Mode Controlled Boost

The parameters shown in the input data windows are defined below:

Steady-state dc operating point

Conduction Mode           It can be Continuous or Discontinuous
Duty Cycle                          ton/T of the active switch
IL avg                                    Inductance average current (A)
IL max                                   Maximum value of the inductance switching ripple (A)
IL min                                    Minimum value of the inductance switching ripple (A)
Io avg                                    Output average current (A)
Vo                                          Output voltage (V)
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Vo Output voltage (V)

Other parameters of the converter

Vin Input Voltage (V)
RL Equivalent Series Resistor of the Inductance (Ohms)
L Inductance (H)
Rc Equivalent Series Resistor of the output capacitor (Ohms)
C Output Capacitor (F)
R Load Resistor (Ohms)
Po Output Power (W)
FSW Switching frequency (Hz)

38



Buck-boost Previous Top Next

In a single loop control scheme there are three possible magnitudes to be controlled in the buck-boost
converter. This is the output voltage, the inductor current and the diode current. The respective
schematics are the following:

Voltage Mode Controlled Buck-Boost
Converter

L-current sensed Buck-Boost Converter

Diode Current Sensed Buck-Boost Converter

In the case of a double loop control scheme, the magnitudes sensed are the output voltage and the L
current.

Buck-Boost (LCS-VMC)

The input data window allows the user to select the desired input parameters and provides useful
information such as the steady state dc operating point. This information is placed right below the
converter image.
Two examples of the input data window are shown below, in each of them, the white shadowed boxes
correspond to the input data boxes while the grey shadowed ones correspond to the additional
information provided by the program.
Please, note that the input data is different in case of a voltage controlled plant (output voltage is an
input) or a current controlled plant (in this case the current to be controlled is the input data). An
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is an input) or a current  controlled plant (in this  case the current to be controlled is  the input
data). An example of the input data windows is provided below:

Input Data Window of a Voltage Mode Controlled Buck-Boost

Input Data Window of a Current Mode Controlled Buck-Boost

The parameters shown in the input data windows are defined below:

Steady-state dc operating point

Conduction Mode It can be Continuous or Discontinuous
Duty Cycle ton/T of the active switch
IL avg Inductance average current (A)
IL max Maximum value of the inductance switching ripple (A)
IL min Minimum value of the inductance switching ripple (A)
Io avg Output average current (A)
Vo Output voltage (V)

Other parameters of the converter
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                Rc           Equivalent Series Resistor of the output capacitor (Ohms)
                C             Output Capacitor (F)
                R             Load Resistor (Ohms)
                Po            Output Power (W)
                FSW         Switching frequency (Hz)
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Flyback Previous Top Next

In a single loop control scheme, the magnitude to be controlled in a Flyback converter can be either the
output voltage or the diode current. Both possibilities have been included in SmartCrl. The schematics
are shown below:
  

Voltage Mode Controlled Flyback Diode Current Sensed Flyback

In the case of a double loop control scheme, the magnitudes sensed are the output voltage and the diode
current.

Flyback (DCS-VMC)

The input data window allows the user to select the desired input parameters and provides useful
information such as the steady state dc operating point. This information is placed right below the
converter image.
Two examples of the input data window are shown below, in each of them, the white shadowed boxes
correspond to the input data boxes while the grey shadowed ones correspond to the additional
information provided by the program.
Please, note that the input data is different in case of a voltage controlled plant (output voltage is an
input) or a current controlled plant (in this case the current to be controlled is the input data). An
example of the input data windows is provided below:

Input Data Window of a Voltage Mode Controlled Flyback
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Input Data Window of a Current Mode Controlled Flyback

The parameters shown in the input data windows are defined below:

Steady-state dc operating point

Conduction Mode           It can be Continuous or Discontinuous
Duty Cycle                          ton/T of the active switch
IL avg                                    Inductance average current (A)
IL max                                   Maximum value of the inductance switching ripple (A)
IL min                                    Minimum value of the inductance switching ripple (A)
Io avg                                    Output average current (A)
Vo                                          Output voltage (V)

Other parameters of the converter

                Vin           Input Voltage (V)
                RL            Equivalent Series Resistor of the Inductance (Ohms)
                L              Inductance (H)
                Rc           Equivalent Series Resistor of the output capacitor (Ohms)
                C             Output Capacitor (F)
                R             Load Resistor (Ohms)
                Po            Output Power (W)
                FSW         Switching frequency (Hz)

(*)          N2 is the transformer secondary side number of turns
                N1 is the transformer primary side number of turns
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Forward Previous Top Next

The magnitude to be controlled in a Forward converter can be either the output voltage or the
inductance current. Both possibilities have been included in SmartCrl. The schematics are shown below:
  

Voltage Mode Controlled Forward L-Current Sensed Forward

In the case of a double loop control scheme, the magnitudes sensed are the output voltage and the L current.

Forward (LCS-VMC)

The input data window allows the user to select the desired input parameters and provides useful
information such as the steady state dc operating point. This information is placed right below the
converter image.
Two examples of the input data window are shown below, in each of them, the white shadowed boxes
correspond to the input data boxes while the grey shadowed ones correspond to the additional
information provided by the program.
Please, note that the input data is different in case of a voltage controlled plant (output voltage is an
input) or a current controlled plant (in this case the current to be controlled is the input data). An
example of the input data windows is provided below:

Input Data Window of a Voltage Mode Controlled Forward
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Input Data Window of a Current Mode Controlled Forward

The parameters shown in the input data windows are defined below:

Steady-state dc operating point

Conduction Mode           It can be Continuous or Discontinuous
Duty Cycle                          ton/T of the active switch
IL avg                                    Inductance average current (A)
IL max                                   Maximum value of the inductance switching ripple (A)
IL min                                    Minimum value of the inductance switching ripple (A)
Io avg                                    Output average current (A)
Vo                                          Output voltage (V)

Other parameters of the converter

                Vin           Input Voltage (V)
                RL            Equivalent Series Resistor of the Inductance (Ohms)
                L              Inductance (H)
                Rc           Equivalent Series Resistor of the output capacitor (Ohms)
                C             Output Capacitor (F)
                R             Load Resistor (Ohms)
                Po            Output Power (W)
                FSW         Switching frequency (Hz)

(*)          N2 is the transformer secondary side number of turns
                N1 is the transformer primary side number of turns
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PFC Boost converter Previous Top Next

The PFC Boost converter is controlled by means of a feedforward and a double loop control scheme.
The inner control loop is a current loop, and the outer loop controls the output voltage.

The PFC Boost converter setup must be built sequentially. The program will guide you to built it,
enabling the following step and keeping everything else disabled.

The first step to define the system is the selection of the plant.

Next, the inner loop setup is going to be completed. First of all the current sensor must be selected
among the available ones.
  

The available current sensors are the
following:

•    Current Sensor
    Hall Effect Sensor

Finally, the inner loop regulator is selected.
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Regulator types:

·    Type 3

·    Type 2

·    PI

·    I

Once all the inner loop transfer functions have been defined, The crossover frequency and the phase
margin must be selected.  Under the name of Solution Map, SmartCtrl provides the stable solution
space in which all the possible combinations of cut off frequency and phase margin that lead to stable
solutions are shown graphically. Just clicking on the "Solutions map (inner loop)" button the solution
map corresponding to the inner  loop is displayed.
The designer is asked to select the crossover frequency and the phase margin  just by clicking within the
white zone to continue.

  

Once the cut off frequency and the phase margin have been selected, the solution map will be shown
on the right of the side of the PFC boost converter input data window. If, at any time, the two
aforementioned parameters need to be changed, just click on the shown solution map. (See next figure)
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Now, the outer loop can be defined. First, the voltage sensor must be selected.

The different sensors available are the
following:

Voltage Divider
Regulator Embedded Voltage
Divider

Next, the outer loop regulator must be selected.

Regulator types:
Type 3
Type 3 Unattenuated
Type 2
Type 2 unattenuated
PI
PI unattenuated
I
I unattenuated

As well as in the  case of the  inner  loop,  the cut off  frequency  and  the  phase  margin  must  be
selected. Also in this case, the solution map is available to help the selection of an stable
solution.
Press the "Solution map (outer loop)" button and the solution map will be displayed. Then select
a point just by clicking within the white area.
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Now accept the selected configuration and confirm the design, the program will automatically show the
performance of the system in terms of frequency response, transient response... (See Graphic and text
panels window for detailed information)
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Voltage divider Previous Top Next

  
The Voltage Divider measures and adapts the output voltage level to the
regulator voltage reference level.

Its transfer function corresponds to the following equation:

 

Where:

Vref is the regulator reference voltage

Vo is the DC/DC converter output voltage
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Reg. Embedded voltage divider Previous Top Next

The two resistors that form the voltage divider (R11,Rar) are embedded within the regulator. So, no
sensor is represented in the corresponding box. And the voltage divider resistors are highlighted in the
regulator figure:

Given the desired output voltage, the regulator reference voltage and the value of R11, SmartCtrl
calculates the resistor Rar. the transfer function of the voltage divider at 0Hz is the following:
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Current sensor Previous Top Next

The current sensor is represented by a generic transfer function box.
Internally, the transfer function corresponds to a constant gain.
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Hall effect sensor Previous Top Next

The Hall effect is a current sensor represented through a generic transfer function box. Internally, its
transfer function corresponds to the following equation:

Where:

Gain is the sensor gain at 0dB.

fpK is the pole frequency in Hertz
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Isolated voltage sensor Previous Top Next

The Isolated voltage sensor is a voltage sensor that provides electrical isolation.  Its transfer function is
described below. It is available for the flyback and the flyback DC/DC topologies.
  

Where:

Gain is the sensor gain at 0dB, its given by
the output and the reference voltage.

Gain= Vo/Vref

fpK is the pole frequency in Hertz
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Type 3 regulator Previous Top Next

Input Data

Gmod   Modulator Gain

R11        Its default value is 10kW

Output Data

The regulator components  values (C1, C2, C3, R1, R2) are calculated by the program and displayed in
the corresponding text panel
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Type 3 regulator unattenuated Previous Top Next

The voltage divider needed in order to adapt the sensed output voltage to the reference voltage is
embedded within the regulator. It corresponds to R11 and Rar. This regulator configuration eliminates
the attenuation due to the external voltage divider.

Input Data

Gmod   Modulator Gain
R11        Its default value is 10k

Output Data

The regulator components  values (C1, C2, C3, R1, R2) and the resistor Rar are calculated by the program
and displayed in the corresponding text panel
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Type 2 regulator Previous Top Next

Input Data

Gmod   Modulator Gain

R11        Its default value is 10kW

Output Data

The regulator components  values (C2, C3, R2) and the resistor Rar are calculated by the program and
displayed in the corresponding  text panel
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Type 2 regulator unattenuated Previous Top Next

The voltage divider needed in order to adapt the sensed output voltage to the reference voltage is
embedded within the regulator. It corresponds to R11 and Rar. This regulator configuration eliminates
the attenuation due to the external voltage divider.

Input Data

Gmod   Modulator Gain
R11        Its default value is 10k

Output Data

The regulator components  values (C1, C2, C3, R1, R2) and the resistor Rar are calculated by the program
and displayed in the corresponding text panel
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PI regulator Previous Top Next

Input Data

Gmod   Modulator Gain

R11        Its default value is 10kW

Output Data

The regulator components  values (C2, R2) are calculated by the program and displayed in the
corresponding text panel
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PI regulator unattenuated Previous Top Next

The voltage divider needed in order to adapt the sensed output voltage to the reference voltage is
embedded within the regulator. It corresponds to R11 and Rar. This regulator configuration eliminates
the attenuation due to the external voltage divider.

Input Data

Gmod   Modulator Gain
R11        Its default value is 10k

Output Data

The regulator components values (C2, R2) and the resistor Rar are calculated by the program and
displayed in the corresponding text panel.
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Single Pole regulator Previous Top Next

Input Data

Gmod   Modulator Gain

R11        Its default value is 10kW

Output Data

The regulator components  values (C3 and R2) is calculated by the program and displayed in the
corresponding text panel
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Single Pole regulator unattenuated Previous Top Next

The voltage divider needed in order to adapt the sensed output voltage to the reference voltage is
embedded within the regulator. It corresponds to R11 and Rar. This regulator configuration eliminates
the attenuation due to the external voltage divider.

Input Data

Gmod   Modulator Gain
R11        Its default value is 10k

Output Data

The regulator component  value (C3 and R2) and the resistor Rar are calculated by the program and
displayed in the corresponding text panel
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Graphic and text panels Previous Top Next

The window is divided in six different panels. Four of them are graphic panels and the two other are text
panels.

The graphic panels are:

                Bode plot Module (dB)

                Bode plot Phase (º)

                Polar plot

                Transient response plot

The text panels are:

                Input Data

                Output Data
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Bode plots Previous Top Next

The Bode plot is used to characterize the frequency response of the system. It consists of two different
graphs, the gain or module plot and the phase plot versus frequency. Frequency is plotted in a log axe.

Module plot (dB)                 Plots the module of a given transfer function in decibels (dB) versus
frequency. It is represented in the upper left panel of the SmartCtrl
window.

Phase plot (º)                        Plots the phase of a given transfer function in degrees versus
frequency. It is represented in the bottom left panel of the SmartCtrl
window.

In SmartCtrl there are seven different transfer functions that can be plotted in the Bode plots. To
represent any of them, just click on the corresponding icon of the View Toolbar or select the
corresponding transfer function within the View Menu.

Manual placement of poles and zeros

Additionally, when a type 3 or type 2 is used, poles and zeros of the compensator are represented by
means of three little squares.

                Yellow   corresponds to fz

                Red        corresponds to fp

                Blue       corresponds to fi

The placement of the aforementioned zeros and poles can be varied by the designer just by clicking
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and dragging on each square. To enable this option manual method tag in the design method box must
be selected.

Cross frequency

The cross frequency of the open loop is shown by means of a pair of dashed lines on the open loop
transfer function of the system.

Copy to clipboard

Another useful tool included in the Bode plots panel is the copy to clipboard option. Just right click on
any of the Bode plot panels will allow the user to copy the current graphs to the clipboard.

Measurement tools

Two different types of cursors are available:

Ctrl + mouse          Keep the Ctrl key pressed and move the mouse. Two crossed red lines are displayed
and the two coordinates of the point on which the mouse is placed are given. You can
measure at any point within the graph area.

Shift+mouse          Keep the Shift key pressed and place the mouse near one of the displayed module
traces. The cursor will track itself to that trace, and the cursor will measure
simultaneously the phase and module of the tracked trace.

                                    If you want to track the cursor to other trace, just left click on that trace.

                                    Additionally, if the selected trace is the open loop transfer function, SmartCtrl will
measure simultaneously on both Bode plots (module and phase) and on the Nyquist
diagram.
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Polar plot Previous Top Next

The Nyquist diagram, together with the Bode plots, is a graphical representation of the frequency
response of a linear system.

For each , the resulting open loop transfer function is represented as Im(T) vs R(T). So, the gain at this
 is the distance from the represented point to the origin, and the phase is the corresponding angle.

In terms of stability, the polar Nyquist diagram provides a graphic and easy to evaluate criterion of the
closed loop system stability based on the open loop system frequency response. This is, if the open loop
transfer function is stable (no RHP poles), the closed loop system will be unstable for any encirclement
of the point (-1, j0).

In Smartctrl the designer can determine the system stability at a glance since a unity circle is provided
(in blue).

Poles and zeros

Poles and zeros of the compensator are represented by means of three little squares.

                Yellow   corresponds to fz

                Red        corresponds to fp

                Blue       corresponds to fi

However, unlike in the Bode plots, they cannot be placed manually.

Measurement tool

In order to ease the determination of the gain and phase of any point within the polar plot, a
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measurement tool has been implemented.

If the Ctrl key is press while the mouse arrow is pointing to any point of the open loop transfer function
a polar cursor will be shown, which measures both the gain and the phase. These are given numerically
in the upper left corner of the polar plot panel and in the lower left corner of the polar plot,
respectively. Gain is given both in natural scale and in dB, and phase is given in degrees.

Zoom

A zoom-in and zoom-out tool has been implemented by left-clicking and dragging the mouse within the
white area of the polar plot. The relative scale is given by the radio of the outer circle both in dB and
natural scale.
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Copy to clipboard

The same way as in the Bode plots and the transient response plots, a copy to clipboard option is
available through right click on the polar plot are that will allow the user to copy the current graph to
the clipboard.
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Transient response plot Previous Top Next

Transient response specifications, such as setting time and voltage peak transient values, are usually
critical specifications when designing the control stage of a power converter. Therefore, providing a
quick view to the transient response of the converter may greatly help the designer during the design
process.

In SmartCtrl the three most significant transient responses have been developed. They can be plotted
just by clicking on the corresponding icons of the View Toolbar or selecting the corresponding transient
response within the View Menu.

Export

This option allows the user to export the current transient responses to a file which could be either .txt
or .smv format. It is placed within the menu displayed through right click on the transient response
panel.

Copy

Just through right click on the transient response plot panel will allow the user to copy the current
graphs in the clipboard.

Modify Time step and total time

Right click on the transient response panel also displays this option. Although the time step is adjusted
by the program, the designer is able to modify it in order to check the transient response accuracy since
the obtained response is highly dependant of this parameter.
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Right click on the transient  response panel  also displays this  option.  Although the time step is
adjusted by the program, the designer is able to modify it in order to check the transient
response accuracy since the obtained response is highly dependant of this parameter.

The total time plotted can be also changed by the designer.

70



Text panels Previous Top Next

There upper right and lower right panels are the input data panel and output data panels respectively.

The input data panel summarizes the input parameters of the system such as the plant parameters, the
steady-state dc operating point,  the regulator parameters, etc...

The output data panel shows the regulator resistors and capacitors values as well as the frequencies of
poles and zeros and the most important open loop characteristics. This is, the phase margin, gain margin
and attenuation at the switching frequency.
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Solutions map Previous Top Next

The appropriate selection of fcross and PM is one of the key issues for loop optimization.

In order to ease the first attempt when designing a control loop, an estimation of the stable solutions
space has been developed under the name of solutions map. Based on the selected plant, sensor and
type of regulator, the solutions map provides a “safe operating area” of the different combinations of
fcross and PM that lead to stable systems. The two parameters involved are represented as PM vs
frequency.

             Just by clicking within the white area, a set of (fcross and PM) that lead to an stable
solution is selected.

             The input boxes (white background) are automatically updated

             And so is the attenuation achieved at fsw box. It is an output parameter (grey
background) and represents the attenuation achieved by the open loop at the switching
frequency.

Additionally, when any of the three aforementioned values is uncommonly low or high, the boxes
background are red-colored in order to draw the designer attention.

Boundaries

The boundaries, which determine the valid area (white area), represent the maximum and minimum
phase margin that can be achieved for any kind of compensator.

    The simple integrator is a particular case of any regulator, therefore it provides the lower
PM limit by adding 90 degrees to the phase of the open loop transfer function without
regulator (plant, sensor and modulator) (green line).

    The upper limit of the solution map is given by the maximum phase boost provided by each
kind of compensator (blue line).

In terms of frequency, the solutions space is limited by the switching frequency, fsw.
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Design Methods Previous Top Next

The design method box is enabled or disabled by clicking on the  icon of the View Toolbar.

The design method box includes the following utilities:

Design method  tags

Each tag correspond to one of the three different design methods available for the regulator
calculation, this is:

K-method

K plus method

Manual

Attenuation at switching frequency

This output box displays the attenuation achieved by the open loop transfer function at the switching
frequency.

Solutions map

Based on the selected plant, sensor and type of regulator, the solutions map provides an estimation
if the stable solutions space that lead to stable solutions. The two parameters involved are
represented as PM vs frequency.

Two change the considered cross frequency and the phase margin, the designer can either change
their values in the white-coloured boxes, use the sliders or just click on a different point within the
solutions map.
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K-factor method Previous Top Next

The K factor allow the designer to choose a particular open loop cross-over frequency and phase
margin, and then determine the necessary component values to achieve these results. In SmartCtrl, the
regulator component values are displayed within the results text panel.

The two input parameters of the K factor (fc, PM) can be easily changed in the K method tag of the
design method box.

They can be also modified by clicking on the solutions map and the K method will recalculate the
regulator to fit the new values. Remember that the stable solutions area is the white one.

In SmartCtrl it is possible to use the K method for both, the Type 2 and Type 3 regulators.

K factor for Type 3 regulator

A Type 3 regulator is formed by two zeroes, two poles and a low frequency pole. When a Type 3
regulator is chosen, the K factor method assumes that a double pole and a double zero must be placed
to design the compensator.

·             The double zero is placed at  frequency

·             The double pole is placed at  frequency

Where K is defined as the ratio of the double pole frequency to the double zero frequency and the 
frequency f is the geometric mean between the frequency of the double zero and the frequency of the
double pole.

So, the maximum open loop phase boost is achieved at frequency f, and it is assumed that the regulator
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Where K is defined as the ratio of the double pole frequency to the double zero frequency and
the frequency f is the geometric  mean  between the frequency of the double  zero and the
frequency of the double pole.

So, the maximum open loop phase boost is achieved at frequency f, and it is assumed that the
regulator is designed so that the open loop cross-over occurs at frequency f also.

K factor for Type 2 regulator

A Type 2 regulator is  formed by a single zero, a single pole and a low frequency pole. When a
Type 2 regulator is selected the pole and the zero are placed as follows:

The zero is placed at K
f

The pole is placed at K·f

Where the K factor is defined as the square root of the ratio of the pole frequency to the zero
frequency and f is the geometric mean of the zero frequency and the pole frequency.

The maximum phase boost from the zero-pole pair occurs at frequency f, and it is assumed that
the regulator is designed so that the open loop cross-over occurs at frequency f also.
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Kplus method Previous Top Next

The Kplus method is based on the K-factor and the inputs are the same:

·    The desired cross-over frequency (fc)

·    The target phase margin (PM)

However, unlike K-factor method, cross-over frequency is no longer the geometric mean of the zeroes
and the poles frequencies.

The Kplus method provides an additional design freedom degree with respect to the conventional
Kfactor method, since the Kplus method places the double zero frequency fz a factor “α” below fcross (

) and the poles a factor “β” above fcross ( ).

Where “α” is set from fcross and phase margin. This parameter allows the designer to select the exact
frequency in which the zeroes will be placed. After that, “β” is automatically calculated.

The additional degree of freedom obtained with Kplus can be used as follows:

·    If “α” is set to be lower than K (from the K-factor method), higher gain at low frequencies but
less attenuation at switching frequency (fsw) are obtained.

·    On the contrary, if “α” is set higher than K (from the K-factor method), the control loop has less
gain at low frequency but more attenuation at fsw. It should be remarked that the phase margin
is the same in all cases.

·    When “α” is equal to K, both methods are equivalent.

Therefore, the Kplus method can be used to improve the overall performance of the control loop in
those cases where a slightly larger high frequency ripple could be admitted at the input of the PWM
modulator.

In the same way as the K method, when the Kplus tag is selected, the user can easily change the input
parameters, phase margin and cross-over frequency And also an additional parameter, Kplus, which
corresponds to the aforementioned “α” factor.

They can also be modified by clicking on the solutions map and the Kplus method will recalculate the
regulator to fit the new values. Remember that the stable solutions area is the white one.
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Manual Previous Top Next

This method allows placing poles and zeroes independently from each other. It is used when the
designer would like to refine the results obtained from the K and Kplus methods or when these
automatic methods do not provide a valid solution.

The manual method is provided for both the type 3 and type 2 regulators. Their poles and zeroes
frequencies can be varied by directly dragging and dropping them in the Bode plots.

Or typing the frequencies of poles and zeroes in corresponding input boxes of the design methods box.

In the case of a Type 3 regulator, the designer can adjust the
frequency values of:

    The two zeroes,

    The two poles

    And the low frequency pole

In the case of a Type 2 regulator, the available frequencies are:

    The zero

    The pole

    And the low frequency pole
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PI tuning Previous Top Next

The PI tuning method input parameters are the same as in the K-factor method:

·    Phase margin

·    Cross-over frequency

From these two input parameters, SmartCtrl calculates the both the proportional (Kp) and integral (Kint)
gains and shows them in the corresponding output boxes.

The same as in the other automatic calculation methods, the phase margin and cross-over frequency
can be set directly by clicking in the solutions map.
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Single Pole tuning Previous Top Next

The I tuning method is the equivalent of the manual method but for integral regulators.

The simple integrator is formed by a single pole, which frequency must be selected by the designer.
Given this frequency,  the associated phase margin is automatically calculated by the program.

The solutions map of an integrator is a single line that represents the addition of 90º to the open loop
without regulator transfer function. So, the designer can also determine the cross-over frequency by
clicking in the solutions map, the same way as in the other design methods.

  

79



Parametric Sweep Previous Top Next

The parametric sweep can be accessed either through the Data Menu or the View Toolbar icons. The
SmartCtrl program distinguish among two different parametric sweeps:

Input Parameters Parametric Sweep 

It allows the variation of all the input parameters of the system. These are:

·          General Data

·          Plant

·          Sensor

·          Regulator

Regulator Components Parametric Sweep 

It allows to vary the component values of the regulator. This is, the resistor an capacitor values that
conform the regulator.
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Input Parameters Parametric Sweep Previous Top Next

To access the input parameters parametric sweep the user can either click must click on the button

, placed within the View toolbar or through the Data Menu > Parametric Sweep > Input

parameters.

.

The functions available within the input parameters parametric sweep are the following:

Loop to be modified                         Select which loop would you like to modify. This option is only
available in the case of a double loop design, where the designer can
select amongst the inner loop or the outer loop

Tick box "calculate regulator"      When this box is selected, the regulator is recalculated for each new
set of parameters along the parametric sweep.

                                                                  If it is not selected, the regulator is fixed to the last one calculated

Loop to be shown                              Select which loop results would you like to display. This option is only
available in the case of a double loop design, where the designer can
select amongst the inner loop or the outer loop

Tag "General Data"                           The parameters to be varied are related to the open loop
parameters. The designer is asked to provide a range of variation. The
available parameters are:

                                                                                                Cross Frequency (Hz)

                                                                                                Phase Margin (º)

Tag "Plant"                                The parameters available for variation are related to the plant input
parameters. The user must introduce a minimum and a maximum value for
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the variable selected, in order to provide its range of variation. Only one
parameter can be varied at a time

Tag "Sensor"                            Two different sensor are available for variation. The voltage divider and the
Hall effect sensor. The parameter to be varied in the voltage divider is its
voltage gain (Vref/Vo). In the case of the Hall effect sensor there are to
available parameters: its gain at 0Hz and the pole frequency.

    

Tag "Regulator"                        The parameters available correspond to the modulator gain and the Resistor
R11.
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Tag "Regulator" The parameters available correspond to the modulator gain and
the Resistor R11.
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Regulator Components Parametric Sweep Previous Top 

To access the regulator components parametric sweep the user can either click on the button ,

placed within the view toolbar or through the Data Menu > Parametric Sweep > Regulator
components.

The regulator components parametric sweep is oriented to the variation of the resistors an capacitors
values that conform the regulator. The parametric sweep is available for Type 3 and Type2 regulators.

.

  

84


	SmartCtrl
	Why SmartCtrl?
	Program Layout
	Main menus and toolbars
	File Menu
	Design Menu
	View Menu
	Window Menu
	Main toolbar
	View toolbar

	Import your own plant Transfer Functions
	Imported plant single loop design

	Export
	Export transfer function
	Export regulator to PSIM
	Export transient responses

	Import (Merge)
	Add Function
	Modify Function

	DC/DC converters
	Single loop
	Double loop
	DC/DC Plants
	Buck
	Boost
	Buck-boost
	Flyback
	Forward


	Boost PFC converter
	Sensors
	Voltage divider
	Reg. Embedded voltage divider
	Current sensor
	Hall effect sensor
	Isolated Voltage Sensor

	Regulators
	Type 3 regulator
	Type 3 regulator unattenuated
	Type 2 regulator
	Type 2 regulator unattenuated
	PI regulator
	PI regulator unattenuated
	Single Pole regulator
	Single Pole unattenuated

	Graphic and text panels
	Bode plots
	Nyquist diagram
	Transient response plot
	Text panels

	Solutions map
	Design Methods
	K-factor method
	Kplus method
	Manual
	PI tuning
	Single Pole tuning

	Parametric Sweep
	Input parameters parametric Sweep
	Regulator Components Parametric Sweep



	Text1: 


